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Revision History

The table below displays the revision history for the chapters in this User
Guide.

Chapter Date Version Changes Made
1 December 3.0 Updated Tables 1-1 and 1-2 to include Stratix Ill device support.
All August 2006 2.0 Updated for Quartus Il 6.0 software release.
All July 2005 4.2 Updated for Quartus Il 4.2 software release.
All March 2005 1.0 Initial release.

How to Contact
Altera

For the most up-to-date information about Altera® products, go to the
Altera worldwide web site at www.altera.com. For technical support on
this product, go to www.altera.com/mysupport. For additional
information about Altera products, consult the sources shown below.

Information Type USA & Canada All Other Locations

Technical support www.altera.com/mysupport/ altera.com/mysupport/

(800) 800-EPLD (3753) (408) 544-7000 (1)

(7:00 a.m. to 5:00 p.m. Pacific Time) (7:00 a.m. to 5:00 p.m. Pacific Time)
Product literature www.altera.com www.altera.com
Altera literature services literature @altera.com (7) literature @altera.com (7)
Non-technical customer (800) 767-3753 (408) 544-7000
service (7:00 a.m. to 5:00 p.m. Pacific Time) (7:30 a.m. to 5:30 p.m. Pacific Time)
FTP site ftp.altera.com ftp.altera.com

Note to table:

(1) You can also contact your local Altera sales office or sales representative.

Altera Corporation
December 2006
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Typographic Conventions

Typographic
Conventions

This document uses the typographic conventions shown below.

Visual Cue

Bold Type with Initial
Capital Letters

Command names, dialog box titles, checkbox options, and dialog box options are
shown in bold, initial capital letters. Example: Save As dialog box.

bold type

External timing parameters, directory names, project names, disk drive names,
filenames, filename extensions, and software utility names are shown in bold
type. Examples: fyax, \qdesigns directory, d: drive, chiptrip.gdf file.

Italic Type with Initial Capital
Letters

Document titles are shown in italic type with initial capital letters. Example: AN 75:
High-Speed Board Design.

Italic type

Internal timing parameters and variables are shown in italic type.
Examples: tpja, n+ 1.

Variable names are enclosed in angle brackets (< >) and shown in italic type.
Example: <file name>, <project name>.pof file.

Initial Capital Letters

Keyboard keys and menu names are shown with initial capital letters. Examples:
Delete key, the Options menu.

“Subheading Title”

References to sections within a document and titles of on-line help topics are
shown in quotation marks. Example: “Typographic Conventions.”

Courier type

Signal and port names are shown in lowercase Courier type. Examples: datal,
tdi, input . Active-low signals are denoted by suffix n, e.g., resetn.

Anything that must be typed exactly as it appears is shown in Courier type. For
example: c:\gdesigns\tutorial\chiptrip.gdf. Also, sections of an
actual file, such as a Report File, references to parts of files (e.g., the AHDL
keyword SUBDESIGN), as well as logic function names (e.g., TRI) are shown in
Courier.

Numbered steps are used in a list of items when the sequence of the items is
important, such as the steps listed in a procedure.

Bullets are used in a list of items when the sequence of the items is not important.

The checkmark indicates a procedure that consists of one step only.

The hand points to information that requires special attention.

The caution indicates required information that needs special consideration and
understanding and should be read prior to starting or continuing with the
procedure or process.

The warning indicates information that should be read prior to starting or
continuing the procedure or processes.

The angled arrow indicates you should press the Enter key.

The feet direct you to more information on a particular topic.

vi
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Chapter 1. About this
Megafunction

Device Family

Support

Altera Corporation

August 2006

Megafunctions provide either full or preliminary support for target
Altera® device families, as described below:

B Full support means the megafunction meets all functional and timing
requirements for the device family and may be used in production

designs.

B Preliminary support means the megafunction meets all functional
requirements, but may still be undergoing timing analysis for the
device family. It may be used in production designs with caution.

Table 1-1 shows level of support for each Altera device family.

Table 1-1. Device Family Support (Part 1 of 2)
Device Family Support
Stratix® Il Full
Stratix |1 Full
Stratix [ GX Full
Stratix GX Full
Stratix Full
Cyclone™ Il Full
Cyclone Full
HardCopy® I Full
HardCopy Stratix Full
MAX® 1| Full
MAX 7000 Full
MAX 3000 Full
APEX™ I Full
APEX 20KC Full
APEX 20KE Full
FLEX® 10K Full
FLEX 10KA Full
FLEX 10KE Full

1-1
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Table 1-1. Device Family Support (Part 2 of 2)

Device Family Support
FLEX 6000 Full
ACEX® 1K Full

As design complexities increase, use of vendor-specific IP blocks has
become common design methodology. Altera provides parameterizable
megafunctions optimized for Altera device architectures. Using
megafunctions instead of coding your own logic saves valuable design
time, offering more efficient logic synthesis and device implementation.
Scale the megafunction's size by simply setting parameters.

The 1pm_shiftreg megafunction implements a shift register and offers
many additional features, including:

Fully parameterizable

Synchronous or asynchronous inputs to shift register

Synchronous parallel load

Left/right register shifting

Optional inputs, including clock enable input, serial shift data input,
and parallel input

B Optional outputs, including data output and serial shift data output

The 1pm shiftregmegafunctionis astorage megafunction provided in
the Quartus II® MegaWizard® Plug-In Manager. Shift registers are a type
of sequential logic circuit, mainly for storage of digital data. They are a
group of flip-flops connected in a chain so that the output from one
flip-flop becomes the input of the next flip-flop. Most of the registers
possess no characteristic internal sequence of states. All the flip-flops are
driven by a common clock and are set or reset simultaneously. A shift
register is useful for converting parallel signals to serial signals and vice
versa.

Shift register megafunction provided by Altera is a very versatile
parameterizable block of logic. Thus long delay chains can be instantiated
using this megafunction. This megafunction provides for either left shift
or right shift of the input data bits. Data that has to be shifted is either
loaded in parallel into the registers synchronously or in serial through the
'shiftin'input of the megafunction. The loaded data is then shifted
with the rising edge of clock input.

Altera Corporation
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About this Megafunction

The shift operation is a single clock-edge operation with an active-high
clock enable feature. When enable is High, the input (D) is loaded into the
first bit of the shift register, and each bit is shifted to the next highest bit
position. Figure 1-1 illustrates the shift operations. Cascading of shift
registers is another way of using the 1pm shiftreg megafunction to
achieve higher shift count or bit count.

Optional inputs are available to asynchronously clear or set the registers,
or synchronously clear or set the registers. Using this feature, you can
either set the initial value of all the registers to 1, or to a desired value.
Parallel output g[] is used to read parallel data from the shift register.
Parallel data is always available on the g [ ] outputs at every clock. When
data is shifted serially with every clock, you get the MSB of the q[]
output on the 'shiftout' pin. A shift operation is shown in Figure 1-1.

Figure 1-1. Shift Operation

CE
D
tshift
a A
N L o e
___________________________ ey
Q15 7(

Altera Corporation
August 2006

Common Applications

Use the 1pm_shiftreg megafunction to replace all other types of shift
register functions.

Shift registers enable the development of efficient designs for
applications that require delay or latency compensation. Shift registers
are also useful in synchronous FIFO and content addressable memory
(CAM) designs. Shift registers are often used as the state register in a
sequential device. Usually, the next state is determined by shifting right
and inserting a primary input or output into the next position (for
example, a finite memory machine). They are very effective for sequence
detectors. Shift registers are used for Serial interconnection of systems

1-3
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that keeps interconnection cost low with serial interconnect. Shift
registers are used for Bit Serial Operations. Bit serial operations can be
performed quickly through device iteration.

The 1pm shiftreg megafunction finds applications where there is a
need to shift the data in or out of digital systems. Serial to Parallel
Conversion, Parallel to Serial Conversion, and delay generation for
multistage pipeline stages are some of the common applications of a shift
register.

This megafunction uses one logic cell per bit. Table 1-2 shows the
resource usage for each Altera device family.

Table 1-2. Ipm_shiftreg Resource Usage

Device Family Optimization (7) Width Logic Elements

Stratix Il Balanced 8-Bit | 8 ALUT

Stratix || Balanced 8-Bit | 8 ALUT

Stratix GX Balanced 8-Bit | 8 logic elements
Stratix Balanced 8-Bit | 8 logic elements
Cyclone Il Balanced 8-Bit | 8 logic elements
Cyclone Balanced 8-Bit | 8 logic elements
MAX 11 Balanced 8-Bit | 8 logic elements
MAX 7000 Balanced 8-Bit | 8 registers
MAX 3000 Balanced 8-Bit | 8 registers
APEX I Balanced 8-Bit | 8 registers
APEX 20KC Balanced 8-Bit | 8 registers
APEX 20KE Balanced 8-Bit | 8 registers
FLEX 10K Balanced 8-Bit | 8 registers
FLEX 10KA Balanced 8-Bit | 8 registers
FLEX 10KE Balanced 8-Bit | 8 registers
FLEX 6000 Balanced 8-Bit | 8 registers
ACEX 1K Balanced 8-Bit | 8 registers

Note for Table 1-2:

(1) Choose a design implementation that balances high performance with minimal
logic usage. This setting is available for Cyclone series, MAXII, Stratix, and Stratix
II devices only. The balanced optimization logic option can be set on the
Assignments menu in Analysis and Synthesis settings.

Altera Corporation
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The MegaWizard® Plug-In Manager reports approximate resource
utilization based on user specification and parameters, available in the
lower left corner of the MegaWizard Plug-In Manager screen.

Altera Corporation 1-5
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System
Requirements

MegaWizard
Plug-In Manager
Customization

MegaWizard
Page
Descriptions

Altera Corporation
December 2006

The instructions in this section require the following hardware and
software:

B A PCrunning the Windows 2000/XP, Red Hat Linux Enterprise 3 or
4, or a Sun workstation running the Solaris 8 or 9 operating system
B The Quartus® II software version 6.0 or higher

Use the MegaWizard® Plug-In Manager to specify the 1pm shiftreg
megafunction features for each shift register function in your design.

Start the MegaWizard Plug-In Manager in one of the following ways:

B On the Tools menu, click the MegaWizard Plug-In Manager
command.

B When working in the Block Editor, click MegaWizard Plug-In
Manager in the Symbol dialog box.

B Start the stand-alone version of the MegaWizard Plug-In Manager by
typing the following command at the command prompt:
gmegawiz+

This section provides descriptions of the options available on the
individual pages of the 1pm_shiftreg wizard.

On page 1 of the MegaWizard Plug-In Manager, you can choose to Create
a new custom megafunction variation, Edit an existing megafunction
variation, or Copy an existing custom megafunction variation

(Figure 2-1).

2-1
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MegaWizard Page Descriptions

Figure 2-1. MegaWizard Plug-In Manager [page 1]

MegaWizard Plug-In Manager [page 1] [g|

The Megawizard Plug-In kanager helps you create or modify
dezign files that contain custom wariations of megafunchions.

YWw'hich action do pou want to perform?

* Create a new custom megafunction sariation
" Edit an existing custom megafunction wariation

" Copy an existing custorn megafunction variation

Copyright & 1991-200E Altera Corporation

Cancel | | M et = | |

On page 2a of the wizard, specify plug-in, select device family, output file
type, and name of output file (Figure 2-2). Choose AHDL (.tdf), VHDL
(.vhd), or Verilog HDL (.v). You can also create a clearbox instantiation for
third-party EDA tools.

2-2 Altera Corporation
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Figure 2-2. MegaWizard Plug-In Manager [page 2a]

MegaWizard Plug-In Manager [page 2a]

Ww'hich megafunction wauld you like to customize?

Select a meagafunction from the list below

+-8@ Anithmetic s
+- 88 Communications

+-f§d DSP

+-f8d Gates

+-@ 140

B Interfaces

Memory Compiler

SignalT ap Il Logic Analyzer
Storage
AT 3PRAM

ALTSHIFT_TAPS
ALTSYNCRAM
LPM_FF
LPM_FIFO+
LPM_LATCH
LPM_RaM_DP
LPM_RAM_DP+
LPM_RAM_DO

Wwhich device family will pou be Shratix -

uzing?

“Which type of output file do pou want to create?
" AHDL

 WHDL

&+ “erlog HOL

What name do you want for the output file? Browse...

|treg\D esigh_examplebarchshiftreg_ex1_1.0_restoredsshiftreg_ex1

[ Generate clear box netlist file instead of a default wrapper file
[for use with supported EDA synthesis tooks only)

[ Return ba thiz page for anather create operation

Mote: To compile a project successfully in the Quartuz |1 software,
your design filez must be in the project directory, in the global user
libraries specified in the Options dislog box (T ools menw). or a user
library specified in the ser Libraries page of the Setting: dialog
b [ zsignments men).

Your current uzer library directonies are:

Cancel | <Bac:k| Mext = |

Altera Corporation
December 2006
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MegaWizard Page Descriptions

On page 3 of the wizard, select the width of the output bus, specify the
shift direction, shift register output, and optional inputs. (Figure 2-3).

Figure 2-3. MegaWizard Plug-In Manager [page 3]

MegaWizard Plug-In Manager, - LPM_SHIFTREG [page 3 of 6]

LPM_SHIFTREG

Yersion 6.0 | Abouk ” Docurnentation

Cptional Inputs

shiftreg_ex1 How wide should the 'q' output bus be? |8 [+ | bits
laft zhiff
] load ‘Which direction do vou want the registers to shift?
ot cfta[7 0]
) Left
k—» clock Shl[gng; Right
k— enable -
k— =hiftin Which ouktputs doyou wank (select at least one)?
| Daka oukput

| Serial shift data oukpuk

Do wou want any opkional inputs?
# Clock Enable input
| Serial shift data input
w1 Parallel data input (loadk

Resource Usage
5 It

| Cancel ” < Back ” Mext = ” Finish |

Table 2-1 describes the options on page 3 of the 1pm shiftreg wizard.

Table 2-1. Ipm_shiftreqg MegaWizard Plug-in Manager Page 3 Options (Part 1 of 2)

Function Description
How wide should the 'q' output bus | Select the width for the 'q' output bus. The maximum size of the 'q"'
be? output bus can be 256 bits. Manually enter widths greater than 256.
Which direction do you want the Select'left'or 'right'to define the direction of data shift.

registers to shift?

2-4 Altera Corporation
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Table 2-1. Ipm_shiftreqg MegaWizard Plug-in Manager Page 3 Options (Part 2 of 2)

Function Description
Which outputs do you want (select at | Select 'Data output ' (parallel output), 'Serial shift data
least one)? output', or select both.
Do you want any optional inputs? Select optional inputs to shift register. Select 'Clock Enable input'

to provide enable function to clock input. Load shift register with parallel
data. Use serial shift data input feature to put serial data into shift register.

On page 4, specify synchronous and asynchronous inputs (Figure 2—4).

Figure 2-4. Ipm_shiftreg Wizard [page 4]

MepaWizard Plug-In Manager. - LPM_SHIF TREG [page 4 of 6]

Y LPM_SHIFTREG

Yersion 6.0 | About || Documentation

- ] . .
shiftreg_ex Do you wank any optional inputs?
left =hif
— load Swnchronous inputs Asynchronous inputs
— datal7..0] shiftout Clear 2 Clear
7.0
¥—» clock ol7.0 ot ;
F— enahle 25 .
£— =hiftin o % Settoall 1's
o Sek ko

Resource Usage
3 It

| Cancel || < Back ” Mext = ” Finish |
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MegaWizard Page Descriptions

Table 2-2. Ipm_shiftreqg MegaWizard Plug-in Manager Page 4 Options

Function

Description

Do you want any
optional inputs?

Select synchronous and/or asynchronous inputs. Use synchronous or asynchronous set and
clear inputs of the shift register as optional features.

Synchronous
inputs

Shift register has optional synchronous clear and set inputs. Use '‘clear’ input to clear all
registers synchronously. Use 'set' input to either set all g [ ] outputs to 1’s or to a particular
value specified in 'Set to'field. The sc1r signal affects g [] outputs before polarity is
applied to ports. If both sset and sclr are used and both are asserted, sc1r is dominant.

Asynchronous
inputs.

Shift register has optional asynchronous clear and set options. Use '‘clear'to
asynchronously clear all g [ ] outputs. aclr signal affects g [] outputs before polarity is
applied to ports. Use 'set' input to either set all g [ ] outputs to 1’s or to a particular value
specified in 'Set to'field. The aclr signal affects g [ ] outputs before polarity is applied
to ports. If both aset and aclr are used and both are asserted, ac1r is dominant.

2-6

On page 6 of the wizard, specify the types of files to be generated. Choose
from HDL wrapper file, (<function name>.v | .vhd | .tdf), Block Symbol file
(.bsf), Instantiation template file (<function name>_inst.v), or Verilog
Black Box declaration file (<function name>_bb.v) (Figure 2-5).

Altera Corporation
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Figure 2-5. Ipm_shiftreg Wizard [page 6] -- Summary

MegaWizard Plug-In Manager - LPM_SHIFTREG [page 6 of 6] -- Summary

LPM_SHIFTREG

a Yersion 6.0 I Ahout ” Docurnentation

Summary

Page

When the 'Finish' button is pressed, the Megawizard Plug-In Manager will create

test
left =hift]
«— loac
) clatal 7.0
A0 ittt
7.0
<> clock allz=l
«— enakle
| shittin L T
o o

Resource Usage

S It

the checked Ffiles in the Following list. ¥ou may choose to include or exclude a file
by checking or unchecking its corresponding checkbox, respectively. The state of
checkbaoxes will be remembered for the next MegaWizard Plug-In Manager
SES5ian,

The Megawizard Plug-In Manager will create these files in the directory
C:\Documents and SettingsitcngDesktopipm_shift),

File | Description

[ test.y Y ariation file

[ testinc AHDL Include file

[ test.cmp WYHDL Component declaration file
[ test.bsf Quartus symbol file

[ test_inst.v Inztantiation template file

[ test_bb.v Verilog 'Black Box' declaration file

Altera Corporation
December 2006

For more information about the ports for the 1pm shiftreg
megafunction, refer to the Specifications chapter in this User Guide.

Inferring Megafunctions from HDL Code

Synthesis tools, including the Quartus II integrated synthesis, recognize
specific types of HDL code, automatically inferring the appropriate
megafunction when a megafunction will provide optimal results. The
Quartus II software uses the Altera® megafunction code when compiling
your design, even if it was not specifically instantiated. The Quartus II
software infers megafunctions which are optimized for Altera devices, so
the area and/or performance may be better than generic HDL code. Use
megafunctions to access Altera architecture-specific features, such as
memory, DSP blocks, and shift registers, providing improved
performance compared with basic logic elements.

2-7
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Refer to the Recommended HDL Coding Styles chapter in volume 1 of the
Quartus II Handbook for more information.

When you use the MegaWizard Plug-In Manager to set up and
parameterize a megafunction, it creates either a VHDL or Verilog HDL
wrapper file that instantiates the megafunction (a black-box
methodology). For some megafunctions, you can generate a fully
synthesizable netlist for improved results with EDA synthesis tools, such
as Synplify and Precision RTL Synthesis (a clear-box methodology). Both
clear-box and black-box methodologies are described in the third-party
synthesis support chapters in the Quartus II Handbook.

B Recommended HDL Coding Styles chapter in volume 1 of the Quartus II
Handbook

B Quartus II Integrated Synthesis chapter in volume 1 of the Quartus II
Handbook

B Synplicity Synplify & Synplify Pro Support chapter in volume 1 of the
Quartus II Handbook

B Mentor Graphics Precision RTL Synthesis Support chapter in volume 1
of the Quartus II Handbook

During compilation with the Quartus II software, analysis and
elaboration is performed to build the structure of your design. To locate
your megafunction in the Project Navigator window, expand the
compilation hierarchy and find the megafunction by its name.

To search for node names within the megafunction (using the Node
Finder), click Browse (...) in the Look in box and select the megafunction
in the Hierarchy box.

The Quartus II Simulation tool provides an easy-to-use, integrated
solution for performing simulations. The following sections describe the
simulation options.

Quartus Il Simulation

With the Quartus II Simulator, you can perform two types of simulations:
functional and timing. The functional simulation enables you to verify
the logical operation of your design without taking into consideration the
timing delays in the FPGA. This simulation is performed using only your
RTL code. When performing a functional simulation, you can view
signals that exist before synthesis. You can find these signals with the
Registers: pre-synthesis, Design Entry, or Pin filters in the Node Finder.
The top-level ports of megafunctions are found using these three filters.

Altera Corporation
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In contrast, timing simulation in the Quartus II software verifies the
operation of your design with annotated timing information. This
simulation is performed using the post place-and-route netlist. When
performing a timing simulation, you are able to view signals that exist
after place-and-route. These signals are found with the Post-Compilation
filter of the Node Finder. During synthesis and place-and-route, the
names of RTL signals change. Therefore, it might be difficult to find
signals from your megafunction instantiation in the Post-Compilation
filter. To preserve the names of your signals during the synthesis and
place-and-route stages, use the synthesis attributes keep or preserve.
These are Verilog and VHDL synthesis attributes that direct analysis &
synthesis to keep a particular wire, register, or node intact. Use these
synthesis attributes to keep a combinational logic node so you can
observe the node during simulation. Refer to the Quartus II Integrated
Synthesis chapter in volume 1 of the Quartus II Handbook.

EDA Simulation

Depending on the third-party simulation tool you are using, refer to the
appropriate chapter in the Simulation section in volume 3 of the Quartus II
Handbook. These tool-specific chapters show you how to perform
functional and gate-level timing simulations including megafunctions,
and the necessary files and file directories.

The SignalTap® Il embedded logic analyzer provides a method of
debugging the Altera megafunctions within your design. With the
SignalTap Il embedded logic analyzer, capture and analyze data samples
for top-level ports of the megafunctions in your design while your system
is running at full speed.

To monitor signals from your megafunctions, first configure the
SignalTap II embedded logic analyzer in the Quartus II software, and
include the analyzer as part of your project. The Quartus II software
seamlessly embeds the analyzer with your design in the selected device.

For more information about using the SignalTap II embedded logic
analyzer, refer to the Design Debugging Using the SignalTap II Embedded
Logic Analyzer chapter in volume 3 of the Quartus I1I Handbook.

2-9
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Design Example: Configurable 8-Bit SIPO or PISO Shift Register

Design Example:
Configurable
8-Bit SIPO or
PISO Shift
Register

Example 1

2-10

This design example uses the 1pm shiftreg megafunction to
implement a configurable 8-bit serial in parallel out (SIPO) or parallel in
serial out (PISO) shift register.

Design Files

The design files are available in the Quartus II Projects section on the
Design Examples page of the Altera web site:
http:/ /www.altera.com/support/examples/quartus/quartus.html

Select the “Examples for Ipm_shiftreg Megafunction User Guide” link
from the examples page to download the design files.

In this example, you perform the following tasks:

B Create an 8-bit shift register using the 1pm shiftregmegafunction
and the MegaWizard Plug-in Manager

B Implement design and assign the EP1S10F780C6 device to the project

B Compile and simulate the design

Generate a Configurable 8-Bit SIPO or PISO Shift Register

1. In the Quartus II software, open the
Ipm_shiftreg_DesignExample_ex1.qar project.

2. On the Tools menu, click MegaWizard Plug-In Manager. Page 1 of
the MegaWizard Plug-In Manager appears (Figure 2-6).

Altera Corporation
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Figure 2-6. MegalWizard Plug-In Manager [page 1]

MegaWizard Plug-In Manager [page 1] [E|

The Megawizard Plug-In kanager helps you create or modify
dezign files that contain custom wariations of megafunchions.

YWw'hich action do pou want to perform?

* Create a new custom megafunction sariation
" Edit an existing custom megafunction wariation

" Copy an existing custorn megafunction variation

Copyright & 1991-200E Altera Corporation

Cancel | | M et = | |

3. Select Create a new custom megafunction variation, and click

Next. Page 2a of the MegaWizard Plug-In Manager appears
(Figure 2-7).

Altera Corporation

2-11
December 2006

Ipm_shiftreg Megafunction User Guide



Example 1

Figure 2-7. Ipm_shiftreg Wizard [page 2a]

X)

MegaWizard Plug-In Manager, [page 2a]

Which megafunction would you like to customize? ‘whhich device family will you be Siratis

ng?
Select a megafunction from the list below M

+- &g Anthmetic A “Which type of output file do you want to create?

B Communications ™ AHDL

" WHDL
+- 8 Gates .
4 & /0 i+ Yerilag HOL
+ (@l Interfaces What name do wou want for the output file? Browsse...

&2 Memory Compiler

|treg\D esign_examplehsrchshiftreg_ex1_1.0_restored\shiftreg_ex1

SignalTap Il Logic Analyzer [ Generate clear box netlist file instead of a default wiapper fils
&g Storage [for uge with supported ED& synthesis tools only]
] ALT3PRAM [ Returm ta thiz page far anather create operation
Mote: Ta compile a project successiully in the Quartus |l software,
ALTESHIFT TAPS wour dezign fles must be in the project directary, in the global uzer
o librariez specified in the Options dialog baox [Tools menu), or a user
'ﬁ'P_LS:ECHAM library specified in the User Libraries page of the Settings dialog
— biox [Assignments menu).
LP_FIFO+
LPH LATCH Your curtent user library directories are:
LPt_Rak_DF
LPtd_Rakd_DP+
LP_Rakd_D0
- d_SHIFTREG
Wirtual JTAG v

Cancel | < Back | Mext » | |

4. From the Which device family will you be using? list, select
Stratix.

5. From the Which type of output file do you want to create? option,
click Verilog HDL.

6. In the Storage folder, select LPM_SHIFTREG. Specify the output
file shiftreg_ex1.

7. Click Next. Page 3 appears (Figure 2-8).
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Figure 2-8. Ipm_shiftreg Wizard [page 3 of 6]

MegaWizard Plug-In Manager. - LPM_SHIFTREG [page 3 of 6]

tional Inputs

LPM_SHIFTREG

Yersion 6.0 | Abaut ” Documnentation

shiftreg

el

How wide should the 'g' output bus be? | 8 ~ | bitz

load
data[7..0]

clock
enable
shiftin

TT1 17

left shify

zhiftaut
o7..0]

‘Which direction do you want the registers to shift?
#: Left
Right

‘ihich autputs do yaou wank (select at lzast onel?

Resource Uzage

g It

| Data aukpuk
| Serial shift data autput

Do wou want any optional inpuks?
# Clock Enable input
| Serial shift data input
| Parallel data input (load’

| Cancel || < Back ” Mext = || Finish ‘
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10.

11.

12.

In the How wide should the ‘q” output bus be? list, select 8.

Under What direction do you want the registers to shift?, select
Left.

Under What outputs do you want (select at least one)?, turn on
both the Data output and Serial shift data output options.

Under Do you want any optional inputs?, turn on all three options.

Click Next. Page 4 appears (Figure 2-9).
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Figure 2-9. Ipm_shiftreg Wizard [page 4 of 6]

MegaWizard Plug-In Manager - LPM_SHIFTREG [page 4 of 6]

-’ﬂ LPM_SHIFTREG

Version 6.0 Ahaut Documentation

[1 ] Parameter
Setkings

General Cptional Inputs

Do wou wank any opkional inpuks?

shiftreg_ex1
laft zhiff
x— load Synchronous inputs Asynchranous inpuks
| el shiftout [ Clear ) Clear
of7.0]
—eclock T TR S ey
e [] 5et 1 Ee
— enakle .
< shiftin ] %) Setto all 1's
ki 7 Set ko

Resource Usage
3 Iut

| Cancel ” < Barck ” Mext = ” Finish |

13. Under Synchronous inputs, turn off Clear and Set.
14. Under Asynchronous inputs, turn on Clear and Set.

15. Click Finish. Page 6 appears (Figure 2-10).
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Figure 2-10. Ipm_shiftreg Wizard [page 6 of 6] -- Summary

MegaWizard Plug-In Manager - LPM_SHIFTREG [page 6 of 6] -- Summary

_a LPM_SHIFTREG

Yersion 6.0 I About ” Docurnentation

Surnmary

Page

wWhen the 'Finish' button is pressed, the MegaWwizard Plug-In Manager will create

shiftreg ex1
left shifi]
«— load
s clata[7..0]
o[7..0]
> clock
<« enable
«shiin 5 B
L] o

Resource Usage
8 It

the checked Files in the following list. ¥ou may choose to include or exclude a file
by checking or unchecking its corresponding checkbox, respectively. The state of
checkboxes will be remembered For the next MegaWizard Plug-In Manager
session.

The Megawizard Plug-In Manager will create these files in the directory
C:\Documents and

SattinacibrnAiNackkantibackinallnem  chifbFran NacianFvarnla avl rackavadh

File: | Description

[ shiftreg_exl.v Y ariation file

[ shiftreg_ex1.inc AHDL Include file

O shiftreg_ex1.cmp WHDL Component declaration file
O shiftreg_ex1.bsf Quartus symbol file

O shiftreg_ex1_inst.v Instantiation template file

[ shiftreg_ex1_bb.v Yerilog 'Black Box' declaration file

Altera Corporation
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16. Turn on Verilog ‘Black Box’ declaration file.
17. Turn off AHDL Include file, VHDL Component declaration file,
Quartus symbol file, and Instantiation template file, and click

Finish.

The 1pm_shiftreg module is now built.

Implement the Configurable 8-Bit SIPO or PISO Shift Register

In this example, you assign the EP1S10F780C6 device to the project and
compile the project.

1. Inthe Quartus Il software, on the Assignments menu, click Settings.
The Settings dialog box appears.

2-15
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2. Under Category, select Device (Figure 2-11).

Figure 2-11. Device Settings Dialog Box

Settings - shiftreg_ex1 [$__<|
Categaon:
Files
User Libraries [Current Project] Select the family and device you want to target for compilation.
D ]
+- Timing Anal_l,lsi§ Settings Beiily |Strati:-c j Show in ‘Available devices' list
+- EDA Tool Settings
ilati i : . . Package: By -
+1- Compilation Process Settings Device & Pin Options...
+- Analysis & Synthesiz Settings Fin count: Ay -
+- Fitter Settings Target device
Agzambler (" Auta device selected by the Fitter Speed grade: |Any Bt
D.emgn Assmtant_ * Specific device selected in ‘Available devices' list Core voltage: 1.5
SignalTap |l Logic Analyzer ~ )
Logic Analyzer Interface v Show advanced devices
SignalProbe Setti
NI S S Available devices:
=1 Simulator Settings
Simulation Pawer Name [LEs  [Memor. [P [PLL DL | A
+- PowerPlay Power Analyzer Settings EP1510F484CH 10570 20448 B B 2 &
EP1510F484CE 10570 920448 6 5 2
EP1510F484C7 10570 20448 B g 2
EFP1510F48416 10570 20448 6 g 2
EP1510FE72CE 10570 920448 B 5 2
EP1510FE72C7 10570 520448 B g 2
EF1S10FE72I7 10570 920448 B [ 2
EP1510F780CE 10570 20448 B 3 2
EP1510F780CEES 10570 920448 6 5 2
EP1510F780CE 10570 20448 B g 2 v
Migration compatibility
Migration Devices... J
O rigration devices selected v :

3. In the Family list, select Stratix.

4. Under Target device, click Specific device selected in “‘Available
devices’ list.

5. In the Available devices list, select EP1S10F780C6.
6. Leave the other options in the default state and click OK.

7. On the Processing menu, click Start Compilation.
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8. When the Full Compilation was successful box appears, click OK.

Functional Results—Simulate the 8-Bit Shift Register in
Quartus Il

This section describes how to verify the design example you just created
by simulating the design using the Quartus II Simulator. To set up the
Quartus II Simulator, perform the following steps:

1. In the Quartus II software, on the Processing menu, select Generate
Functional Simulation Netlist.

2. When the Functional Simulation Netlist Generation was
successful message box appears, click OK.

3. On the Assignments menu, click Settings. The Settings dialog box
appears.

4. Inthe Category list, select Simulator Settings (Figure 2-12).
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Figure 2-12. Simulator Settings Dialog Box

Settings - shiftreg_ex1 b__(|
Categony:

General Simulator Settings

Files

User Libraries [Curment Project] Select simulation options.

Device
+- Timing Analysis Settings . ; -

: Simulat de:

41 EDA Tool Seltings imulation mode |Funct|ona| j
+|- Compilation Pracess Settings Sirnulation input; |shiftreg_ex1_ip.vwf
+- Analyzis & Syntheszis Settings
+- Fitter Settings Simulation period

Assembler " Run simulation until all vector stimuli are uzed

Dezign Azsiztant

SignalTap Il Logic Analyzer % End simulation at: |30 e :"
Logic Analyzer Interface
SignalProbe Settings v Automatically add pins to simulation output waveforms

—|- Sirnulatar Settings :
Simulation Power [ Check outputs |

PowerPlay Power Analyzer Settings r
= [ [T
Iv Simulation coverage reporting Feport Settings...

[ Dwvenarite sirmulation input file with sirmulation resulks

~

More Settings...

Description:

]

Specifies the end time for simulatian,

0K Cancel

5. In the Simulation mode list, select Functional.

6. Type shiftreg_ex1_ip.vwf in the Simulation input box, or click
Browse (...) to select the file in the project folder.

7. Select End simulation at:, type 30, and select us from the list.

8. Turn on the Automatically add pins to simulation output
waveforms and Simulation coverage reporting options.

9. Turn off Check points and Overwrite simulation input file with
simulation results and click OK.

2-18 Altera Corporation
Ipm_shiftreg Megafunction User Guide December 2006



Getting Started

10. On the Processing menu, click Start Simulation.

11. When the Simulation was successful message box appears, click
OK.

12. The Simulation Report window displays. Verify the simulation
waveform results (Figure 2-13 and Figure 2-14).

Figure 2-13. Simulation Waveform, SIPO
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Figure 2-14. Simulation Waveform, PISO
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Functional Results—Simulate the 8-Bit Shift Register in
ModelSim-Altera
Simulate the design in ModelSim to compare the results of both
simulators.
This User Guide assumes that you are familiar with using
ModelSim-Altera before trying out the design example. If you are
unfamiliar with ModelSim-Altera, refer to the support page at:
Altera Corporation 2-19
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http:/ /www.altera.com/support/
software/products/modelsim/mod-modelsim.html. The support page
has links to topics such as installation, usage, and troubleshooting.

Set up the ModelSim-Altera simulator by performing the following steps.

1.

Unzip the lpm_shiftreg_ex1_msim.zip file to any working directory
on your PC.

Start Modelsim-Altera.

On the File menu, click Change Directory.

Select the folder in which you unzipped the files. Click OK.
On the Tools menu, click Execute Macro.

Select the shiftreg_ex1.do file and click Open. This is a script file for
ModelSim that automates all necessary settings for the simulation.

Verify the results shown in the Waveform Viewer window.
You can rearrange signals, remove signals, add signals and change
the radix by modifying the script in shiftreg_ex1.do accordingly to

suit the results in the Quartus II Simulator.

Figure 2-15 and Figure 2-16 show the expected simulation results in
ModelSim.

Figure 2-15. ModelSim Simulation Results, PISO
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Figure 2-16. ModelSim Simulation Results, SIPO

DesignExample:
Time Delay

Altera Corporation
December 2006

This design example uses the 1pm shiftreg megafunction to
implement time delay functionality.

Design Files

The design files are available in the Quartus II Projects section on the
Design Examples page of the Altera web site:
http:/ /www.altera.com/support/examples/quartus/quartus.html

Select the “Examples for Ipm_shiftreg Megafunction User Guide” link
from the examples page to download the design files.

Example 2

In this example, you perform the following tasks:

B Create a time delay
B Implement design and assign the EP1510B672C6 device to project
B Compile and simulate the design

Generate the Time Delay Design

1. From the Quartus II software, open the
Ipm_shiftreg DesignExample__ex2.qar project.

2. On the Tools menu, click MegaWizard Plug-In Manager. Page 1 of
the MegaWizard Plug-In Manager appears (Figure 2-17).
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Figure 2-17. MegaWizard Plug-In Manager [page 1]

MegaWizard Plug-In Manager [page 1] [E|

The Megawizard Plug-In kanager helps you create or modify
dezign files that contain custom wariations of megafunchions.

YWw'hich action do pou want to perform?

* Create a new custom megafunction sariation
" Edit an existing custom megafunction wariation

" Copy an existing custorn megafunction variation

Copyright & 1991-200E Altera Corporation

Cancel | | M et = | |

3. Select Create a new custom megafunction variation, and click
Next. The MegaWizard Plug-In Manager page 2a displays
(Figure 2-18).
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Figure 2-18. MegaWizard Plug-In Manager [page 2a]

MegaWizard Plug-In Manager [page 2a] E|
Which megafunction would you like to customize? Which device family will you be |Strali:-< j
g
Select a megafunction from the list below B
+-8g Aithmetic A Which type of output file do you want to create?
+-& Communications ™ AHDOL
+-&g D5P © HDL
+ B Gates ]
< & 10 {+ Werilog HOL
+-8g Irterfaces '
What name do you want for the output file? Browse...

+-@& Memory Compiler
|iftleg\.DeSign_e:-:ample'\src\shiﬂleg_e:ﬂ _1.0_restaredsshiftreq_ex2

SignalTap Il Logic Analyzer [ Generate clear box netlist file instead of & default wrapper file
Starage [for uze with supported EDA synthesiz tools only)

ALTIFRAM [ Return to this page for another create operation
Mate: To compile a project succezsfully inthe Quartus | software,
ALTSHIFT TAPS pour design files must be in the project directarny, in the global user
o libraries specified in the Options dialog box [Tools menw), or & user
'ﬁlp_LS\;EEHﬂM library specified in the Uzer Libranes page of the Settingz dialog
- bow [Azzighments menu).
LPM_FIFO +
LPM_LATCH Your current uzer library directaries are:
LPM_Rak_DP
LPM_Rak_DP+
LPM_Rak_D0
LPM_ROM
Bl LP_SHIFTREG
Yirtual JTAG v

Cancel ‘ < Back ‘ Mest > | |

4. In the Storage folder, select LPM_SHIFTREG. Specify the output
file as shiftreg_ex2.

5. In the Which device family will you be using? list, select Stratix.

6. For Which type of output file do you want to create?, select Verilog
HDL.

7. Click Next. Page 3 appears (Figure 2-19).
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Figure 2-19. Ipm_shiftreg Wizard [page 3 of 6]

MegaWizard Plug-In Manager, - LPM_SHIFTREG [page 3 of 6]

-,a LPM_SHIFTREG

Yersion 6.0 | abouk ” Cocurnentation

Optional Inputs

shiftreg ex2 How wide should the 'g output bus be? |8 [ | bits
left zhift
| clock Which direction do wou want the regiskers to shift?
r— enable .
" shiftout * Left
zhiftin
Right

Which outputs dao wou want {select at least one)?
[Daka oukput
# Serial shift data oukput

Do wou wank any optional inpuks?

1 Serial shift data inpuk
Parallel data input (load)

Resource Usage

g It
| Cancel ” < Back. ” Mext = ” Einish |

8. In the How wide should the ‘q” output bus be? list, select 8.

9. Under What direction do you want the registers to shift?, select
Left.

10. Under Which outputs do you want (select at least one)?, turn off
Data output and turn on Serial shift data output.
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11. Under Do you want any optional inputs?, turn on Clock Enable
input and Serial shift data input, and turn off Parallel data input
(load).

12. Click Next. Page 4 appears (Figure 2-20).

Figure 2-20. Ipm_shiftreg Wizard [page 4 of 6]

MegaWizard Plug-In Manager - LPM_SHIFTREG [page 4 of 6]

LPM_SHIFTREG

Yersion 6.0 | Abouk ” Docurmentation

onal Inputs

Do wou wank any optional inputs?

shiftreg_ex?

left shift
clock . Synchronous inputs Asynchronous inputs
shiftout
Enable [ Clear M Clear
zhiftin
L] get o et
® Settoall1's
1 Setto

Rezource Uzage

& It
| Zancel ” < Back ” Mext = ” Finish |
13. Under Synchronous inputs, turn off Clear and Set.
14. Under Asynchronous inputs, turn on Clear and turn off Set.
15. Click Finish. Page 6 appears (Figure 2-21).
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Figure 2-21. Ipm_shiftreg Wizard [page 6 of 6] -- Summary

MegaWizand Plug-In Manager - LPM_SHIFTREG [page 6 of 6] -- Summany

\d

e LPM_SHIFTREG

Yersion 6.0 | bk || Docurnentation

Surnrnaty

Page

Wwhen the ‘Finish' button is pressed, the MegaWizard Plug-In Manager will create

shiftrag_ex? the checked files in the Following lisk, ¥ou may choose ko include or exclude a file
Toft =i by checking or unchecking its corresponding checkbox, respectively, The state of
clock ) checkboxes will be remembered for the next MegaWizard Plug-In Manager
shiftout session
enable '

=hiftin

The Meqga'izard Flug-In Manager will create these files in the directary
C\Documents and

Cattinact rhlarcar Packbani W avlFilact Dr niack o Man sFhoncHanch inm chifbraahDacian

File: | Description

[ shiftreg_ex2 v Wariation file

[ zhiftreq_ex2.inc AHDL Ihchide file

[ szhiftreq_ex2.cmp WHOL Component declaration file
[ shiftreg_ex2. bst Quartus symbol file

[ shiftreg_ex2_inst.v Instantiation template file

[ zhiftreq_ex? bbow Werilog ‘Black Bow' declaration file

Resource Uzage

5 It
16. Turn on the Verilog ‘Black Box’ declaration file option.
17. Turn off AHDL Include file, VHDL Component declaration file,
Quartus symbol file, and Instantiation template file, click Finish.
The 1pm_shiftreg module is now built.
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Implement the Time Delay Design

This section describes how to assign the EP1510F780C6 device to the
project and compile the project.

1. From the Quartus II software, on the Assignments menu, select
Settings. The Settings dialog box appears.

2. Inthe Category list, select Device. The Device Settings dialog box
appears (Figure 2-22).

Figure 2-22. Device Settings Dialog Box

Settings - shiftreg ex1 [z|
Categony:
Files
User Libraries [Current Project] Select the family and device pou want to target for compilation.
+- Timing AnaIyS|§ Settings Eerily |Stratix j Shaw in ‘Awvailable devices' list
+- ED& Tool Settings
ilati i 5 . . Package: Ay -
+|- Compilation Process Settings Device & Pin Options...
+- Analpzizs & Synthesiz Settings Pin count: Ay -
+- Fitter Settings Target device
Assembler " Auto device selected by the Fitter Speed grade: | Any bt
Design Assistant (+ Specific device selected in ‘Available devices!' list Core voltage: 1.5V
SignalT ap |l Logic Analyzer ~ ;
Logic Analyzer Interface I Show advanced devices
SignalProbe Setti
ol Available devices:
= Simulator Settings
Simulation Power Name LEs Memor. [DSP | PLL [ DLL A~
+- PowerPlay Power Analyzer Settings EF1510F484CH 10570 920448 B B 2 L1
EF1510F454CE 10570 20448 B [ 2
EP1510F484C7 10570 920448 B g 2
EP1510F4584I6 10570 520448 B E 2
EP1510FET2CE 10570 920448 B g 2
EFP1510FET2CT 10570 520448 B [ 2
EP1510FE72I7 10570 920448 B g 2
EFP1510F750CS 10570 920448 B [ 2
EP1510F7S0CEES 10570 920448 B g 2
EP1510F7E0CE 10570 920448 B [ 2 v
Migration compatibility
Migration Devices... J
0 migration devices selected o -
Ok | Cancel |

3. In the Family list, select Stratix.
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4. Inthe Target device list, click Specific device selected in “Available
devices’ list.

5.  Under Show in ‘Available devices’ list, select EP1S10F780C6.
6. Leave the other options in the default state and click OK.
7. On the Processing menu, click Start Compilation.

8. When the Full compilation was successful message box appears,
click OK.

Functional Results—Simulate the Time Delay Design in
Quartus II
This section describes how to verify the design example you just created

by simulating the design using the Quartus II Simulator. To set up the
Quartus II Simulator, perform the following steps:

1. From the Quartus II software, on the Processing menu, click
Generate Functional Simulation Netlist.

2. When the Functional Simulation Netlist Generation was
successful message box appears, click OK.

3. On the Assignments menu, click Settings. The Functional
Simulation Settings window appears.

4. Inthe Category list, select Simulator Settings. The Simulator
Settings dialog box appears (Figure 2-23).
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Figure 2-23. Simulator Settings Dialog Box

Settings - shiftreg _ex2

Category:

General
Files
User Libraries [Current Project)
Device
Timing Analysis Settings
ED& Tool Setting:
Compilation Process Settings
Analyziz & Synthesiz Settings
Fitter Settings
Aszembler
Desgign Agsistant
SignalT ap Il Logic Analyzer
Logic Analyzer Interface
SignalProbe Settings
Simulator Settings

Simulation Power
PowerPlay Power Analyzer Settings

][] [ [

T

Select simulation options.

Simulation mode: |Functi0nal

=l
Simulation input: |shiftreg_ex2_ip.vwf o

Simulation period

" Run simulation until all vectar stimuli are used

' End simulation at; |40 T -

[v Autornatically add ping to simulation output wavefoms
[ Check outputs |
-

= T
[+ Simulation coverage reporting Report Settings. ..

[7 Owenwrite gimulation input file with simulation results

~

Maore Settings. .

D egcription:

Specifies the end time for zimulation.

oK | Cancel

10.
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In the Simulation mode list, select Functional.

Type shiftreg_ex2_ip.vwf in the Simulation input box, or click
Browse (...) to select the file in the project folder.

Turn on the End simulation at: option, type 40 and select us.

Turn on Automatically add pins to simulation output waveforms

and Simulation coverage reporting options.

Turn off Overwrite simulation input file with simulation results,

and click OK.

On the Processing menu, click Start Simulation.
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11. When the Simulation was successful message box appears, click
OK. The Simulation Report window displays. Verify the simulation
waveform results (Figure 2-24).

Figure 2-24. Functional Simulation Waveform
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Functional Results—Simulate the Time Delay Design in
ModelSim-Altera

Simulate the design in ModelSim to compare the results of both
simulators.

This User Guide assumes that you are familiar with using
ModelSim-Altera before trying out the design example. If you are
unfamiliar with ModelSim-Altera, refer to the support page at:

http:/ /www.altera.com/support/
software/products/modelsim/mod-modelsim.html. The support page
has links to topics such as installation, usage, and troubleshooting.

Set up the ModelSim-Altera simulator by performing the following steps.

1. Unzip thelpm_shiftreg_ex2_msim.zip file to any working directory
on your PC.

2. Start Modelsim-Altera.
3. On the File menu, click Change Directory.
4. Select the folder in which you unzipped the files. Click OK.

5.  On the Tools menu, click Execute Macro.
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6. Select the shiftreg_ex2.do file and click Open. This is a script file for
ModelSim that automates all necessary settings for the simulation.

7. Verify the results shown in the Waveform Viewer window.
You can rearrange signals, remove signals, add signals and change
the radix by modifying the script in shiftreg_ex2.do accordingly to

suit the results in the Quartus II Simulator.

Figure 2-25 shows the expected simulation results in ModelSim.

Figure 2-25. ModelSim Simulation Results

cOn C | usio n The Quartus II software provides parameterizable megafunctions
ranging from simple arithmetic units, such as adders and counters, to
advanced phase-locked loop (PLL) blocks, multipliers, and memory
structures. These megafunctions are performance-optimized for Altera
devices and therefore, provide more efficient logic synthesis and device
implementation, because they automate the coding process and save
valuable design time. Altera recommends using these functions during
design implementation so you can consistently meet your design goals.
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Ports &

Parameters

The options listed in this section describe all of the ports and parameters
available for each device to customize the 1pm_shiftreg megafunction
according to your application. Figure 3-1 shows ports and parameters for
the 1pm_shiftreg megafunction.

Figure 3-1. Port and Parameter Description
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Table 3-1 shows input ports, Table 3-2 shows output ports, and Table 3-3
shows parameters.

The parameter details are only relevant for users who bypass the
MegaWizard® Plug-In Manager interface and use the megafunction as a
directly parameterized instantiation in their design. The details of these
parameters are hidden from the user of the MegaWizard Plug-In Manager
interface.

Refer to the latest version of the Quartus® IT Help for the most current
information on the ports and parameters for this megafunction.

Table 3-1. Ipm_shiftreg Megafunction Input Ports (Part 1 of 2)

=

(-3
Port Name ‘E__ Description Comments

-]

o
datal] No | Data input to the shift register. | Input port LPM_WIDTH wide. At least one of data, aset,

aclr, sset, sclr and/or shiftin ports must be used.

clock Yes | Positive-edge-triggered clock.
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Table 3-1. Ipm_shiftreqg Megafunction Input Ports (Part 2 of 2)

=
(-1
PortName | S Description Comments
o«
enable |No |Clock enable input. Shift options use enable input for clock enable. Enable must
be high (1) or unconnected for serial operation. Load must be
high (1) and enable must be high or unconnected for parallel
load operation.
Shiftin |No | Serial shift data input. At least one of data, aset, aclr, sset, sclr and/or
shiftin ports must be used. Default value is VCC.
load No | Synchronous parallel load. Default is low (0) shift operation. For parallel load operation,
High (1): load operation; low |load must be high (1) and enable must be high or
(0): shift operation. unconnected.
sclr No | Synchronous clear input. If both sset and sc1r are used and both are asserted, sc1r
is dominant. sc1r signal affects g [ ] outputs before polarity
is applied to ports.
sset No | Synchronous set input. Sets g outputs to value specified by LPM SVALUE, if that
value is present, or sets the q outputs to all 1s. If both sset
and sclr are used and asserted, sclr is dominant. sset
signal affects g [ ] outputs before polarity is applied to ports.
aclr No | Asynchronous clear input. If both aset and aclr are used and both are asserted, aclr
is dominant. aclr signal affects the g [] outputs before
polarity is applied to the ports.
aset No | Asynchronous set input. Sets g [ ] outputs to the value specified by LPM_AVALUE, if
that value is present, or sets the g [ ] outputs to all 1s. If both
aset and aclr are used and both are asserted, aclr is
dominant. aset signal affects g [ ] outputs before polarity is
applied to ports.
Table 3-2. Ipm_shiftreqg Megafunction Output Ports
=
o
Port Name | S Description Comments
3
ql] No | Dataoutputfrom | Output port LPM_WIDTH wide. Either g[] or shiftout or both must
the shift register. | be used.
shiftout |No |Serial shift data |Either g[] or shiftout or both must be used. shiftout port value
output. is equal to g [LPM_WIDTH-1] when LPM_DIRECTION="LEFT”.
When LPM_DIRECTION="RIGHT”, shiftout equals q[0].
3-2 Altera Corporation
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Table 3-3. Ipm_shiftreqg Megafunction Parameters
=
o
Parameter Type | = Comments
2
LPM WIDTH Integer | Yes | Width of the data[] and g ports.
LPM String |No | Values are “LEFT”, “RIGHT”, and “UNUSED”. If omitted, default is “LEFT”. MSB
DIRECTION is the leftmost bit, LSB is rightmost bit. The MSB is g [LPM_WIDTH-1].
LPM AVALUE |Integer | No |Constant value loaded when aset is high. If omitted, defaults to all 1s. The
/ String LPM_AVALUE parameter is limited to a maximum of 32 bits. Altera recommends
that you specify this value as a decimal number for AHDL designs.
LPM SVALUE |Integer | No |Constant value that is loaded on the rising edge of clock when sset is high. If
/ String omitted, defaults to all 1s. Altera recommends that you specify this value as a
decimal number for AHDL designs.
LPM HINT String | No | Allows you to specify Altera-specific parameters in VHDL Design Files (.vhd).
The default is “UNUSED”.
LPM TYPE String | No | Identifies library of parameterized modules (LPM) entity name in VHDL Design
Files.
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